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Copyrights

© Cypress Semiconductor Corporation, 2014. The information contained herein is subject to change without notice.
Cypress Semiconductor Corporation assumes no responsibility for the use of any circuitry other than circuitry embodied in a
Cypress product. Nor does it convey or imply any license under patent or other rights. Cypress products are not warranted
nor intended to be used for medical, life support, life saving, critical control or safety applications, unless pursuant to an
express written agreement with Cypress. Furthermore, Cypress does not authorize its products for use as critical
components in life-support systems where a malfunction or failure may reasonably be expected to result in significant injury
to the user. The inclusion of Cypress products in life-support systems application implies that the manufacturer assumes all
risk of such use and in doing so indemnifies Cypress against all charges.

Source Code

Any Source Code (software and/or firmware) is owned by Cypress Semiconductor Corporation (Cypress) and is protected
by and subject to worldwide patent protection (United States and foreign), United States copyright laws and international
treaty provisions. Cypress hereby grants to licensee a personal, non-exclusive, non-transferable license to copy, use,
modify, create derivative works of, and compile the Cypress Source Code and derivative works for the sole purpose of
creating custom software and or firmware in support of licensee product to be used only in conjunction with a Cypress
integrated circuit as specified in the applicable agreement. Any reproduction, modification, translation, compilation, or
representation of this Source Code except as specified above is prohibited without the express written permission of
Cypress.

Disclaimer

CYPRESS MAKES NO WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, WITH REGARD TO THIS MATERIAL,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE. Cypress reserves the right to make changes without further notice to the materials described
herein. Cypress does not assume any liability arising out of the application or use of any product or circuit described herein.
Cypress does not authorize its products for use as critical components in life-support systems where a malfunction or failure
may reasonably be expected to result in significant injury to the user. The inclusion of Cypress’ product in a life-support
systems application implies that the manufacturer assumes all risk of such use and in doing so indemnifies Cypress against
all charges.

Use may be limited by and subject to the applicable Cypress software license agreement.
Trademarks

Purchase of 12C components from Cypress or one of its sublicensed Associated Companies conveys a license under the
Philips 12C Patent Rights to use these components in an I12C system, provided that the system conforms to the 12C
Standard Specification as defined by Philips. As from October 1st, 2006 Philips Semiconductors has a new trade name -
NXP Semiconductors. All trademarks or registered trademarks referenced herein are property of the respective
corporations.

Flash Code Protection

Cypress products meet the specifications contained in their particular Cypress Datasheets. Cypress believes that its family
of products is one of the most secure families of its kind on the market today, regardless of how they are used. There may
be methods, unknown to Cypress, that can breach the code protection features. Any of these methods, to our knowledge,
would be dishonest and possibly illegal. Neither Cypress nor any other semiconductor manufacturer can guarantee the
security of their code. Code protection does not mean that we are guaranteeing the product as "unbreakable." Cypress is
willing to work with the customer who is concerned about the integrity of their code. Code protection is constantly evolving.
We at Cypress are committed to continuously improving the code protection features of our products.
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Thank you for your interest in the HX3 Blaster Plus tool. This is a Windows-based tool that enables configuring HX3
features on hardware with an 1°C EEPROM attached to HX3.

1.1 Getting Started

This user guide describes the features of the HX3 Blaster Plus tool and how to use it. The HX3 Blaster Plus Tool section
explains the procedure to use the tool. The Troubleshooting section lists the troubleshooting procedure.

1.2 Additional Learning Resources

Visit the HX3 web page at www.cypress.com/hx3 for additional learning resources including datasheets and application
notes.

1.3Technical Support

For assistance, go to www.cypress.com/go/support or contact our live customer support at +1 (800) 858-1810 (in the U.S.)
or +1 (408) 943-2600 (international) and follow the voice prompt.

1.4Document Conventions

Table 1. Document Conventions for Guides

Convention Usage

Courier New Displays file locations, user-entered text, and source code:
C:\ ...cd\icc\

Italics Displays file names and reference documentation:
The “Configuration Options” section of the HX3 datasheet gives more details about the use
of pin straps

File > Open Represents menu paths:
File > Open > New Project

Bold Displays commands, menu paths, and icon names in procedures:
Click the File icon and then click Open.

Times New Roman Displays an equation:
2+2=4

Text in gray boxes Describes Cautions or unique functionality of the product.

HX3 Blaster Plus User Guide, Doc. No. 001-90185 Rev. *B 4
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1.5Abbreviations

Table 2. List of Abbreviations

OBIntroduction

Abbreviation

Meaning

BC Battery charging

CDP Charging downstream port
DCP Dedicated charging port
DVK Development kit

ESD Electrostatic discharge
GUI Graphical user interface
I‘C Inter-integrated circuit

KB Kilobyte

PC Personal computer

PID Product ID

RDK Reference design kit

ROM Read-only memory

usB Universal Serial Bus
USB-IF Universal Serial Bus Implementers Forum
VID Vendor ID

HX3 Blaster Plus User Guide, Doc. No. 001-90185 Rev. *B
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2.1 HX3 Blaster Plus Software

Follow these steps to install the Hx3 Blaster Plus tool on a Windows PC:

1.

Download the tool package from www.cypress.com/go/hx3blasterplus and start the installation. The tool package is

available in the following installer formats for download:

= HX3 Blaster Plus Setup (HX3BlasterPlusSetup.exe): This installation package contains the files related to the
tool. It does not include the Windows installer and Microsoft .NET Framework packages. If these packages are not
installed on your computer, the installer automatically redirects to the Internet to download the packages. Run the
.exe file after downloading to start the installation.

= HX3 Blaster Plus ISO (HX3BlasterPlus.iso): This file is a complete package stored in a CD-ROM image format
that you can use to create a CD or extract the file using an 1ISO extraction program such as WinZip or WinRAR, so
that you can run cyautorun.exe to start the installation. This file includes the HX3 Blaster Plus tool, HX3 Blaster
Plus User Guide, and Release Notes.

Select Typical for Installation Type and click Next, as shown in Figure 1.

Figure 1. Initiating HX3 Blaster Plus Installation

f ™

Product Installation Overview
Choose the install type that best suits your needs

Choose the type of installation

Product:
HX3 Blaster Plus

Installation Type:

~ @@ T~
& >

Installs the most common features of HX3

Blaster Plus.
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3. Read and accept the Cypress End-User License Agreement and click Next to continue, as shown in Figure 2.

Figure 2. Cypress End-User License Agreement

i~ ™
& Cylnstaller for HX3 Blaster Pm- [ER

License Agreement

You must read and accept the license before you install the software

License Agreement

CYPRESS END USER LICENSE
AGREEMENT

PLEASE FEAD THIS END USER. LICENSE AGREEMENT ("Agreement")

CAREFULLY BEFORE DOWNLOADING, INSTALLING, OR USING THIS
SOFTWARE AND ACCOMPANYING DOCUMENTATION ("Software"). BY
DOWNLOADING, INSTALLING, OR USING THE SOFTWARE. YOU ARE
AGREEING TO BE BOUND BY THIS AGREEMENT. IF YOU DO NOT AGREE TO
ALL OF THE TERMS OF THIS AGREEMENT. PROMPTLY RETURN AND DO it

m| »

@) | accept the terms in the license agreement

() | do not accept the terms In the lIcense agreement

"

4. Wait for the installation to complete.
5. After the installation is complete, the contents are available at the following location:
HX3 Blaster Plus : <Install Directory>\HX3 Blaster Plus

Note: On Windows 32-bit platforms, the default <Install Directory> is C:\Program Files\Cypress, and on Windows 64-bit
platforms, it is C:\Program Files(x86)\Cypress.

2.2 Install Hardware

The HX3 Blaster Plus tool does not require any hardware installation.

2.3Uninstall Software

You can uninstall the tool using one of the following methods:

= Goto Start > All Programs > Cypress > Cypress Update Manager; click the Uninstall button associated with the
“HX3 Blaster Plus” entry in the Cypress Update Manager table.

= Goto Start > Control Panel > Programs and Features; select the program “HX3 Blaster Plus” from the list and click
the Uninstall/Change button.

HX3 Blaster Plus User Guide, Doc. No. 001-90185 Rev. *B 7
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This section describes the capabilities of the HX3 Blaster Plus tool and the procedure to run the tool with an HX3-based
hardware or kit. It uses CY4609, CY4603, and CY4613 hardware as a reference; however, the same procedure can be
used on any HX3-based hardware.

3.1 Overview

HX3 Blaster Plus is a GUI-based tool to configure the HX3 hub controller. It can be used to configure any HX3-based
hardware with a compatible EEPROM connected to HX3 over I°C. This tool allows you to do the following:

= Read configuration data from the EEPROM and display the values.

=  Download custom firmware from a PC via HX3 and store it on the EEPROM.

= Download custom firmware and configuration data together and store it on the EEPROM.
=  Configure HX3 and download only the configuration data to the EEPROM.

= Erase the firmware and configuration data from the EEPROM.

=  Generate HX3 configuration data to be sent over the I°C bus when HX3 is configured as an I°C slave.

3.2Setup

Figure 3 displays the setup to run the HX3 Blaster Plus tool with the HX3-based hardware.
Figure 3. HX3 Blaster Plus Tool Setup

USB 3.0/2.0 EEPROM
Cable USB 3.0 HX3 Hub I2C | |Configuration Data
Upstream (<> < >
Port Controller

Firmware

HX3 Hub Controller-Based Hardware

Windows PC With USB 2.0/3.0 Port

The HX3 Blaster Plus tool is installed on a Windows PC (Windows XP; Windows Vista; Windows 7, 8, or 8.1). The PC
needs to have a USB 3.0 or USB 2.0 port. The PC is connected to HX3 using a USB 3.0 or 2.0-certified cable. The HX3-
based hardware has an external EEPROM connected to HX3 over I°C.
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3.3Procedure to Run HX3 Blaster Plus

Figure 4 provides the steps to run HX3 Blaster Plus.
Figure 4. Steps to Run HX3 Blaster Plus

START

Connect HX3 Hardware to PC

l

Install CYUSBHX3 Vendor Driver on
the PC

l

Perform Required Operation
(Configuration or Firmware Download)
Through Blaster Plus GUI

!

Uninstall CYUSBHX3 Vendor Driver on
the PC

ONOINO

©

3.3.1 Connect HX3-Based Hardware to a PC

Follow these steps to connect the HX3-based hardware to a PC:

1. Configure the firmware boot mode to Custom Firmware on the HX3-based hardware.
2. Power on the HX3-based hardware.
3. Connect the HX3-based hardware to a USB 3.0 or 2.0 port on the PC.

3.3.2 Install CYUSBHX3 Vendor Driver on a PC

To run the HX3 Blaster Plus tool, the default Windows hub class driver that is automatically bound to the USB 2.0 interface
of the HX3-based hardware needs to be unbound, and the CYUSBHX3 vendor driver needs to be bound.

To install the device driver on Windows 7, do the following:
1. Connect the HX3 hardware to one of the USB ports.
= Invoke the Device Manager and search for a USB 2.0 hub device with the properties given in Table 3.

Table 3. Identifying USB 2.0 Hub

Hardware VID PID

CY4609 04B4 6502
CY4603 04B4 6506
CY4613 04B4 650A

HX3 Blaster Plus User Guide, Doc. No. 001-90185 Rev. *B 9
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= Check the VID and PID details in Properties > Details tab > Hardware Ids, as shown in Figure 5.
Figure 5. Identifying VID and PID

L ™y

|Genem| I Driver | Details | Power Managemerrt|

USB 20 MTT Hub

Property

lHardware lds ,]

Value VID: 04B4

[USB\VID_04B48PID_65028REV_501A < PID: 6502
DID: 501A

Note: The DID value displayed above may vary depending on the HX3 firmware version

2. Once the device is identified, right-click and select Update Driver Software, as shown in Figure 6.
Figure 6. Updating Driver Software
s =

File Action View Help
e D EI HE & E &S

&[4 Security Devices
[» -8 SM Driver
&% Seund, video and game controllers

[->-<:— Storage controllers

;{8 System devices

a- ﬂ Universal Serial Bus controllers

§ Generic USB Hub

§ Generic USB Hub

i HUAWEI Mobile Connect - Bus Enumerate Device

i Intel(R) 7 Series/C216 Chipset Family USE Enhanced Host Contreller - 1E26
i Intel(R) 7 Series/C216 Chipset Family USE Enhanced Host Contreller - 1E2D
i Intel(R) USE 3.0 eXtensible Host Controller

i Intel(R) USE 3.0 Reot Hub

{E USB 2.0 MT-" B

i USE 3.0 Hu Update Driver Software...
Disa

Uninstall

§ USBRootH

Scan for hardware changes

Launches the Update Drive

Properties

Note: When HX3-based hardware is connected to a PC over a USB 3.0 port, the Device Manager lists one hub with
USB 2.0 capability and another hub with USB 3.0 capability. Be sure to invoke Update Driver Software only on the
hub with USB 2.0 capability, as HX3 Blaster Plus can work only with a hub that has UBS 2.0 capability.
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3. In the Update Driver Software window, click on Browse my computer for driver software,

HX3 Blaster Plus Tool

as shown in Figure 7.

On the next screen, click on Let me pick from a list of device drivers on my computer and click Next, as shown in

Figure 8.
Figure 7. Searching for CYUSBHX3 Driver

How do you want to search for driver software?

= Search automatically for updated driver software
Windows will search your computer and the Internet for the latest driver software
for your device, unless you've disabled this feature in your device installation
settings.

< Browse my computer for driver software
Locate and install driver software manually.

Figure 8. Locating CYUSBHX3 Driver

[l Update Driver Software - Generic USB Hukb

Browse for driver software on your computer

Search for driver software in this location:

| - Browse...

[# Include subfolders

et me pick from a list of device drivers on my computer
This list will show installed driver software compatible with the device, and all driver
software in the same category as the device,
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4. Click Have Disk, as shown in Figure 9.
Figure 9. Loading CYUSBHX3 Driver Path

Update Driver Software - USB 2.0 MTT Hi

Select the device driver you want to install for this hardware.

Select the manufacturer and moedel of your hardware device and then click Next. If you have a
< diskthat contains the driver you want to install, click Have Disk.

Show compatible hardware

Model

[5IUSB 2.0 MTT Hub
[IUSE Hub

_e—
@ This driver is digitally signed. ‘
Tell me why driver signing is important

G

5. Select the driver file by navigating to <Install Directory>\HX3 Blaster Plus\drivers\<operating system>\<x64/x86> and
click OK. You can browse for the location using the Browse button, as shown in Figure 10.

Figure 10. Loading CYUSBHX3 Driver

- - -

@ I Update Driver Software - USB 2.0 MTT Hub Lookin: ||| x4 - e L? P [~

T Name Date modified Type

Select the device driver you want to install for this hardware. P ] CyUsBHa 11/25/2013 807 PM  Setup Infec

Select the manufacturer and model of your hardware device and then click Next. If you have a
< diskthat contains the driver you want to install, click Have Disk.

i Desktop
H Install From Disk | =
[Z] Show compatible hardware &
Insert the manufacturer's installation disk. and then -
Model a:y make sure that the comect dnve is selected below Libraries
| ES USE 2.0 MTT Hub h’&'
|
I [/ USB Hub
Computer
@' < T 3
. . Copy manufacturer’s files from MNetwork
B This driver is digitally signe ;
Tell me why driver signing AN e Browss. Fog CyusBFcnt ;]
Files of type Setup Information ("inf)

“rer

Note: On Windows 32-bit platforms, the default <Install Directory> is C:\Program Files\Cypress, and on Windows 64-bit
platforms, it is C:\Program Files(x86)\Cypress.

HX3 Blaster Plus User Guide, Doc. No. 001-90185 Rev. *B 12
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6. Select Cypress HX3 Vendor Mode, as shown in Figure 11.

Figure 11. Selecting Driver Type

@ | Update Driver Software

Select the device driver you want to install for this hardware.

Select the manufacturer and model of your hardware device and then click Mext. If you havea
<% disk that contains the driver you want to instal, click Have Disk.

< [ Cypress HX3 Vender Mode >
e

@ This driver has an Authenticode(tm) signature.

Tell me why driver signing is important

7. Click Yes in the Update Driver Warning window, as shown in Figure 12.

Figure 12. Confirming Installation of Driver

[ Update Driver Warning

. Installing this device driver is not recommmended because Windows
LIL cannot verify that it is compatible with your hardware, If the driver is
not compatible, your hardware will not work correctly and your
computer might become unstable or stop working completely. Do you
want te continue installing this driver?

8. Accept the driver signature by selecting the check box Always trust software from “Cypress Semiconductor
Corporation” and click Install, as shown in Figure 13.

Figure 13. Enabling Installation of the Driver

v R ==

Would you like to install this device software?

Name: Cypress Universal Serial Bus controllers
d- Publisher: Cypress Semiconductor Corporation

Always trust software from "Cypress Install ] D Don't Install
iconductor Corporation”,

@ You should only install driver software from publishers you trust. How can I decide which device
software is safe to install?

HX3 Blaster Plus User Guide, Doc. No. 001-90185 Rev. *B 13
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9. Once the installation is successful, click Close to close the window, as shown in Figure 14.
Figure 14. Successful Installation of CYUSBHX3 Driver

Windows has successfully updated your driver software

Windows has finished installing the driver software for this device:

Cypress HX3 Vendor Mode

10. Restart the PC if required.

HX3 Blaster Plus User Guide, Doc. No. 001-90185 Rev. *B
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3.3.3 Perform Configuration Using the HX3 Blaster Plus Tool

1. Invoke the HX3 Blaster Plus tool from Start > All Programs > Cypress > HX3 Blaster Plus > HX3 Blaster Plus. The
Blaster Plus GUI is displayed as shown in Figure 15.

Figure 15. GUI Layout of HX3 Blaster Plus Tool

Title Bar

Feature Tabs

HX3 Blaster Plus Tool

Configuration Data

Eile Device Help
Fdme
Select 3 HXdevice: " [[] Always dispiay settings from EEPROM Raw corfiguration data
e e @ st Byte -
[ - oad to o evices = sz B
|Conﬁgu-e HX3 Setiings [Define USB String Desciptors | | 01 B3 |
1 & L4
iguration type: {r ton D : Cs ion C + String h 202 030
General settings GPIO Control Port settings 03 D4
ViD: Port indicators:
%0484 b1 us DS 1 Ds2 DS Ds4 04 B0
USB3.0PID %6504 Disable 55 LED b0 55 Active b1 b1 b1 1
USB 2.0PID pre Disable green LED: o0 e e = = T = 005 | B4
DiD d5000 Disable amber LED b0 55 Tx amplitude (V) 10V - 10V 10V - 10V - 10V D06 04
Embedded Hub: o fg;nenj ‘r"d'ﬁ“’f :;Eﬁb'e' b0 55 T driver de-emphasis (db} 34ds v | 34db 34db - 34db = 3ddb 07 | M
ower on time: modulate enable: o
5 &5 s HS Active: b1 b1 b1 b1 08 | S
it B p— HS oy sl iy’ = i & e 50
Accept llegal descriptor: 1 arging Control ) oa : B 09 00
Ghost chargs enable = iver pre-smphasis enable B0 b0 50 b0 50
Compound device: bO . . E E e0A 250
S5 US pott disable: Battery charging b1 HS dver pre-emphasis depth (%): 0% - +10% 0% - +10% - +10%
2 b0 -
ACA dock: o0 HS amplitude boost (%) Defauk  w Dafaut Defauk  w Defauk = Defauk OB | 00
Apple charging limit 00 Removable port: b1 b1 b1 b1 bIC | OOF
: = Enable CDP: bl b1 bl bl 0D 32
ower switch settings Enable DCP L0 00 ) L0
Ganged power switching: b0 OO OeFF
Over cument polarity. b Common HS PHY settings [eOF 10
Power enable polarity: 50 HS driver slope {%): Defauk o m
Reference voltage for HS squelch mV): 120 v &
D11 11
12 i)
T et Read Sef D Firmware: . Do iare + Seff Configure |2C. 13 68 | .
|I Initialized Blaster Plus for use with 83 pin device without Shared Link, 0. of devices connected: 0 ‘ Package: NONEl HX3 F/W version: 0.0.0.0 | EEPROM Status: NOT COMNECTED

Command Bar

 E—

Status Bar

HX3 Blaster Plus includes two tabs: Configure HX3 Settings and Define USB String Descriptors. The title bar of the
application shows the currently selected device. The status bar displays the following information:

] Error, warning, and status messages
] Package type of HX3 used on the hardware
= Firmware version stored on the hardware

. EEPROM content status: The EEPROM status displays five status values: NOT CONNECTED, BLANK, F/W,

F/W+SETTINGS, and SETTINGS.

The Configuration Data section of the GUI displays the flat view of the current configuration data shown in the feature

tabs.

HX3 Blaster Plus User Guide, Doc. No. 001-90185 Rev. *B
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Table 4 provides an overview of the seven groups of configuration settings supported by the HX3 Blaster Plus tool.

Table 4. Configuration Setting Groups

Configuration Setting Description
Group
General Settings This group of parameters is related to hub descriptor fields that are sent to the

host. These controls are per the USB-IF hub specification and change the
enumeration details of HX3.

GPIO Control This group controls the default behavior of GPIO pins and Port Status Indicator
LED pins. The HX3 Blaster Plus tool gives you an option to drop the Port Status
Indicator LEDs to free up the GPIOs.

Charging Control This group consists of configurable parameters related to USB Battery Charging,
proprietary charging, and Ghost Charging™.

Power Switch Settings This group consists of configurable parameters related to HX3 power
management controls such as Power Enable polarity, overcurrent polarity, and
ganged power switching.

Port Settings This group consists of configurable parameters related to port-specific features
such as Shared Link™, dedicated charging port (DCP), charging downstream port
(CDP), and port polarity swapping. Also the Physical Layer (PHY) parameters for
each port can be tuned per the hardware design.

Common HS PHY Settings | This group consists of configurable parameters related to advanced, high-speed
PHY settings common to all the downstream and upstream ports.

USB String Descriptors This group consists of three configurable string descriptors, including
manufacturer string descriptor, product string descriptor, and serial number string
descriptor.

2. Click the Configure I2C button. Select the appropriate values for the 12C frequency, 12C type, Read page size, and
Write page size parameters based on the EEPROM used on the HX3 hardware, as shown in Figure 16.

Figure 16. Setting I°C Parameters

Configure 12C @

|2C frequency: | 100 KHz - |
12C type: [ Large 12 -
|2C address: xA2

Read page size (bytes):  d256

Write page size (bytes): d64

|2C corfiguration: bet203

Ok l ‘ Cancel
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Select the HX3 device from the Select a HX3 device drop-down list, as shown in Figure 17.

Figure 17. Selecting HX3 device

-
@ HX3 Blaster Plus - Cypress HX3 Vendor Mode [VID&PID : 0434&'.6502_

File Device Help
>
Eda e
Select 2 Lo [] Atways display settings fiom EEPROM
Cypress HX3 Vendor Mode [VID&PID : 04B4&6502] =D

-~
y 4

Configure HX3 Settings | Define USB Sting Descr |

Configuration type: [r‘ ion D - Ca ion C + String ] ']

il
Select the configuration type, as shown in Figure 18.

Figure 18. Selecting Configuration Type

-
@ HX3 Blaster Plus - Cypress HX3 Vendor Mode [VID&PID : 0434&'.6502_

File Device Help
=1% -1

Select a HX3 device: [7] Aways display setiings from EEPROM

[ Cypress HX3 Vandor Mode VID&PID : 04B486502] -

Configure HX3 Setﬁngsw = :
I Configuration type: § ion D : C ion C + Swing d D

HX3 Blaster Plus Tool

Configuration type (Configuration A to Configuration D) determines the number of parameters that can be configured
using the HX3 Blaster Plus tool GUI. Configuration A enables a minimum number of parameters, and Configuration D

enables a maximum number of parameters. Table 5 lists the configurable parameters for each configuration type.

Table 5. Configurable Parameters for Each Configuration Type

Configuration Setting Configurable Parameters* Configuration Type
Group
A** B** C
VID X X X
USB 3.0 PID X X X
USB 2.0 PID X
DID X X X
Embedded hub X X
Controller power X X
General Settings
Power-on time X X
OC timer X X
Accept illegal descriptor X X
Compound device X X
Legacy host driver support X X
SS US port disable X X
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Configuration Setting

Configurable Parameters*

Configuration Type

Group
Ar* B* C
Port indicators X X
Disable SS LED X X
Disable green LED X X
GPIO Control
Disable amber LED X X
Suspend indicator disable X X
LED modulate enable X X
Ghost charge enable X X
Battery charging X X
Charging Control
ACA dock X X
Apple charging limit X X
Ganged power switching X X
Power Switch Settings Overcurrent polarity X X
Power enable polarity X X
SS Active X X
Shared Link enable X X
SS Tx amplitude (V) X
SS Tx driver de-emphasis (db) X
HS Active X X
HS swap port polarity X X
Port Settings
HS driver pre-emphasis enable X
HS driver pre-emphasis depth (%) X
HS amplitude boost (%) X
Removable port X X
Enable CDP X X
Enable DCP X X
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Configuration Setting

Configurable Parameters*

Configuration Type

Group
A** B** C D
HS driver slope (%) X X
Common HS PHY Settings
Reference voltage for HS squelch (mV) X X
Manufacturer string descriptor X
USB String Descriptors Product string descriptor X
Serial number string descriptor X

* Refer to the EEPROM Map table in the HX3 datasheet for more details about these configuration parameters. The
EEPROM Map table describes the location and default value for the configuration parameters.

** \When Configuration types A and B are selected, the firmware assigns USB 2.0 PID by incrementing the value assigned
to USB 3.0 PID by 2. For example, if you enter ‘6550’ for USB 3.0 PID, the firmware assigns ‘6552’ for USB 2.0 PID.

5.  Now you can perform the following operations:

= Edit and download configuration settings to the EEPROM.
= Download firmware to the EEPROM.
= Erase the contents of the EEPROM.

= Read the configuration settings from the EEPROM.

6. The following example illustrates the procedure to change VID for the USB 3.0 hub interface and verify the updated

parameter.

= Click Always display settings from EEPROM check box located near the menu bar to read the current settings

stored on the EEPROM

=  Modify the value of USB 3.0 PID under the General Settings group to x7500.

= Click the Download Firmware + Settings... button in the command bar to write the modified settings to the
EEPROM along with custom firmware, as shown in Figure 19.

Figure 19. Downloading Custom Firmware and Configuration Settings

Power switch settings

Ganged power switching:

Ower current polarty:

Power enable polarity:

b0
b0

Enable DCP:

Common HS PHY settir
HS driver slope (%)

Reference voltage for

L

Download Settings... ] [ Read Settings ] [ Download Firmware... ‘ Download Fimware + Settings... ’

Initialized Blaster Plus for use with 658 pin device.

Note: Since the HX3 hardware is configured for custom firmware mode by default, always be sure to download the
firmware along with the configuration settings. Also ensure that the HX3 hardware is designed with a large 12C
EEPROM to accommodate both the firmware and settings.
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= Click Yes to confirm the download operation, as shown in Figure 20.

Figure 20. Confirmation of Firmware and Configuration Settings Download

i This operation overwrites EEPROM contents with new firmware and

settings. Would you like to continue?

GO ™ ]

= Provide the path to the HX3 firmware (HX3 EEPROM FW.bin) in the dialog box and click Open, as shown in
Figure 21. You can find the HX3 firmware at <Install Directory>\HX3 Blaster Plus\Firmware.

Figure 21. Confirmation of Firmware and Configuration Settings Download
' '
&3 Cpen u
@ 1.« Cypress » HX3 Blaster Plus » Firmware - | | Search Firmware pe)

Organize » Mew folder = 0 @

3

& Downloads “  Mame Date modified Type Size

“E-:—l Recent Places " )
— @EEPROM FW A3.bin y12/2013 8:50 AM  VLC media... 9 KB

- Libraries
@ Documents
J‘ Music
[ Pictures
H videos

1M Computer
&, Windows7_05 (C)
i5 DVD RW Drive (D:) Setup

File name: | ~ | Binfiles ("bin) - |

I Open |VI [ Cancel ]

Note: The “version” number shown in Figure 21 may vary depending upon the latest HX3 firmware version.
Contact Cypress technical support at cypress.com/go/support for HX3 firmware related queries.

= Wait for the status bar to get updated, as shown in Figure 22, denoting successful downloading of the
configuration parameters and firmware to the EEPROM.

Figure 22. EEPROM Download Confirmation

Download Firmware... |

ownloaded firmware [version: 0xAS] with settings to EEPROM.

= Reset the HX3 hardware by pressing the reset switch (SW1 on CY4603, CY4609 and CY4613) for the downloaded
firmware to be effective.
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Identify the USB 3.0 hub entry in the Device Manager for the HX3 hardware and check the PID, as shown in
Figure 23.

Figure 23. Updated PID

USB 2.0 Hub Properties ‘ 5

| General I Driver ‘ Details |Power Management‘

USB 3.0 Hub

Property
[Hardware Ids A
' Value VID: 04B4
USB\VID_04B4&PID_75008REV_500A <
PID: 7500
DID: 500A

R

Note 1: When the HX3 Blaster Plus tool is invoked, it identifies the configuration parameters that can be modified
for the HX3 part used on the given hardware and disables editing of all other parameters.

Note 2: Some configuration parameters include subparameters. In these cases when a configuration parameter is
disabled, all the subparameters are disabled as well. For example, disabling “SS Active” for “DS 1" disables all its
subparameters. These subparameters are displayed in the GUI under the configuration parameter.

Note 3: Once the configuration data along with the firmware is written to the EEPROM, the pin strap features are
disabled, as the configuration data stored in the EEPROM overrides all other settings. To enable the pin strap
features again, download only the custom firmware to the EEPROM using the HX3 Blaster Plus tool and power
cycle the HX3 hardware.

Note 4: When configuration data is downloaded to multiple HX3 devices by enabling Download to all connected
devices, the same serial number will be used for all the devices.

Note 5: While specifying value for the configuration parameters, make sure that the HX3 board design can support
the values wherever applicable. For e.g., if the HX3 board design uses 'active low' signal to indicate 'over current'
state on downstream port, only 0 can be assigned as the value for 'Over current polarity' parameter in Blaster Plus.
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3.3.4 Generate an I°C Slave-Mode File to Configure HX3 Hardware in I°C Slave Mode

HX3 Blaster Plus Tool

HX3 supports I°C slave-mode operation, which enables the configuration of HX3 from an external I°C master. In order to
perform this operation, an “HX3 I°C Slave Mode file” needs to be generated using the Blaster Plus tool. This file contains

HX3 configuration parameters and the custom firmware. Follow the steps given below to generate this file.

1. Connect the HX3 hardware to a PC running the Blaster Plus tool and specify the required configuration settings on the

Blaster Plus GUI.

2. Select File > Generate HX3 I12C Slave Mode File as Figure 24 shows.

Figure 24. Generating I°C Slave-Mode File

File | Device

Help

B L0

Load Settings...
Save Settings...

Reset Settings

Ctrl+0
Ctrl+S

,

Generate HX3 2C Slave Mode File...  Ctrl+E

Exit

General settings
VID:

USE 2.0 PID:

GPIO Control
Port indicators:

Disable 55 LED:

3. On the Generate HX3 I2C Slave Mode File dialog box, select the Include hx3 firmware file and settings option as
Figure 25 shows. Select the 12C master frequency based on the frequency to be used by the I°C master device that

will be connected to the HX3 hardware.

Note Because the HX3 hardware is configured for custom-firmware mode by default, always select the Include hx3

firmware file and settings option.

Provide the path to the HX3 firmware file (HX3 EEPROM FW.bin) in the Firmware file to include field. The HX3
firmware file is available under <Install Directory>\HX3 Blaster Plus\Firmware. Also provide the path to store the output
file in the Generated file path field and click Export.

Figure 25. Dialog box to generate HX3 12C slave mode file

-
(3 Generate HX3 12C Slave Mode File

[S55)

COptions

Iﬂ Include o3 firmware file and settings I

) Include onty hex3 settings

12C master frequency:

100 KHz

-

Firmware file to include:

Generated file path:

[7] Open destination folder after export

12C conhguration value: 003

Note: After the HX3 I°C slave-mode file is generated, the HX3 hardware needs to be configured for I°C slave-mode
operation and connected to an I’C master to download the HX3 I°C slave-mode file. Refer to the given HX3 hardware

implementation details as required.
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3.3.5 Uninstall CYUSBHX3 Vendor Driver

Once the CYUSBHX3 driver is installed, the device ceases to function as the HX3 hub, and it can be used with the HX3
Blaster Plus tool only. To bring the device back to hub functionality, you need to uninstall the CYUSBHXS3 driver associated
with the hardware as follows:

1. Close the HX3 Blaster Plus tool if it is running.

2. Open the Device Manager and locate the Cypress HX3 Vendor Mode device. Right-click on the device and select
Uninstall, as shown in Figure 26.

Figure 26. Uninstalling CYUSBHX3 Driver

File Action View Help
Lol ARl RERN ? ol SN

o -4 Security Devices -
» g8 SM Driver

[ IL:; Smart card readers

»-% Sound, video and game controllers

» {8 System devices
4- ﬂ Universal Serial Bus controllers
----- i Cypress HX3 Vendor Mode

----- @ Generic USB Hub Update Driver Software...
..... @ Generic USB Hub Disable
..... § Intel(R) 7 Series/C216 Chip @ £2D
..... § Intel(R) 7 Series/C216 Chip - =26 F
----- § Intel(R) USB 3.0 eXtensible Scan for hardware changes
..... § Intel(R) USB 3.0 Root Hub
@ USB3.0Hub e =

----- i USE Composite Device
----- a USBE Mass Storage Device
..... § USB Root Hub

..... § USB Root Hub =z

Uninstalls the driver for the selected device.

3. Select Delete the driver software from this device and click OK, as shown in Figure 27.
Figure 27. Initiating Uninstall of CYUSBHX3 Driver

-
Confirm Device UninstalA ﬂ

Cypreszs HX3 Vendor Mode

Waming: You are about to uninstall this device from your system.

Delete the driver software for this device.

4. Restart the PC if required.

This procedure restores the hub driver, and the attached hardware can be used as the normal USB 3.0 hub.
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4.Troubleshooting

4.1 Troubleshooting Guide

Problem

HX3 Blaster Plus tool does
not list the HX3 board that
is connected to the PC on

the tool’s title bar.

Configurations set using
the HX3 Blaster Plus tool
are not enabled after
running the tool.

Installation of the
CYUSBHX3 driver that is
required to run the HX3
Blaster Plus tool fails with a
“code 10" error.

After configuring the kit
using the HX3 Blaster Plus
tool, the enumeration of the
hardware fails.

Unable to install
CYUSBHX3 driver on
Windows XP after changing
the USB 2.0 PID using the
HX Blaster Plus tool.

The HX3 Blaster Plus tool
does not list the HX3 board
any longer after modifying
the configuration settings

Possible Cause

The CYUSBHX3 vendor driver may not
be bound on the USB port to which the
HX3 board is connected.

The configuration mode selection
jumpers may not have been set
correctly.

The USB 3.0 host controller on the PC
may not be compatible with the
CYUSBHX3 driver (for example,
ASMedia USB 3.0 host controller based
PC).

During configuration using the HX3
Blaster Plus tool, DCP may have been
enabled on all the downstream ports.
When DCP is enabled, a downstream
port will work only as a charging port.

During configuration using the HX3
Blaster Plus tool, a setting incompatible
with to the hardware may have been
enabled.

The new USB 2.0 PID value set may
not be supported by the CYUSBHX3
driver on Windows XP.

The change in configuration settings
might have caused the CYUSBHX3
vendor driver binding to be lost
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Possible Solution

Ensure that the CYUSBHX3 vendor driver is
bound before invoking the HX3 Blaster Plus
tool.

Ensure that the hardware is configured for
custom firmware mode using the configuration
mode selection jumpers.

Ensure that the configuration mode selection
jumpers are fitted tightly.

Restart the hardware either by power cycling
the hardware or by pressing the reset switch
(SW1) after setting the configuration mode
selection jumpers.

Try installing the CYUSBHX3 driver on
another PC with a different USB 3.0 host
controller (such as Intel or Renesas).

Configure the hardware to use ROM firmware.
Invoke the HX3 Blaster Plus tool and disable
DCP on the required downstream ports using
the HX3 Blaster Plus tool. Configure the
hardware to use custom firmware

Configure the hardware to use ROM firmware.
Invoke the HX3 Blaster Plus tool, erase the
EEPROM, and configure new settings.
Configure the hardware to use custom
firmware

Configure the hardware to use ROM firmware.
Invoke the HX3 Blaster Plus tool and restore
USB 2.0 PID to the default value.

Rebind the CYUSBHX3 vendor driver using
the procedure described in section 3.3.2
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